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1 General information
1.1 About this documentation

This documentation is an integral part of the product. The documentation is intended
for all employees who perform work on the product.
Make sure this documentation is accessible and legible. Ensure that persons respon-
sible for the systems and their operation as well as persons who work with the product
independently have read through the documentation carefully and understood it. If you
are unclear about any of the information in this documentation, or if you require further
information, contact SEW‑EURODRIVE.

1.2 Content of the documentation
The descriptions in this documentation apply to the software and firmware versions
applicable at the time of publication. These descriptions might differ if you install later
software or firmware versions. In this case, contact SEW‑EURODRIVE.

1.3 Other applicable documentation
Observe the corresponding documentation for all further components.
Always use the latest edition of the documentation and the software.
The SEW‑EURODRIVE website (www.sew‑eurodrive.com) provides a wide selection
of documents for download in various languages. If required, you can also order prin-
ted and bound copies of the documentation from SEW‑EURODRIVE.

1.4 Short designation
The following short designations are used in this documentation.

Designation Short designation
DriveRadar® DataCollector Software

Industrial Internet of Things IIoT
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1.5 Structure of the warning notes
1.5.1 Meaning of signal words

The following table shows the grading and meaning of the signal words for safety
notes.

Signal word Meaning Consequences if disregarded

 DANGER Imminent hazard Severe or fatal injuries

 WARNING Possible dangerous situation Severe or fatal injuries

 CAUTION Possible dangerous situation Minor injuries

NOTICE Possible damage to property Damage to the product or its envi-
ronment

INFORMATION Useful information or tip: Simplifies
handling of the product.

1.5.2 Structure of section-related safety notes
Section-related safety notes do not apply to a specific action but to several actions
pertaining to one subject. The hazard symbols used either indicate a general hazard
or a specific hazard.
This is the formal structure of a safety note for a specific section:

SIGNAL WORD
Type and source of hazard.

Possible consequence(s) if disregarded.
• Measure(s) to prevent the hazard.

Meaning of the hazard symbols
The hazard symbols in the safety notes have the following meaning:

Hazard symbol Meaning
General hazard

1.5.3 Structure of embedded safety notes
Embedded safety notes are directly integrated into the instructions just before the de-
scription of the dangerous action.
This is the formal structure of an embedded safety note:

 SIGNAL WORD Type and source of hazard. Possible consequence(s) if disregar-
ded. Measure(s) to prevent the hazard.
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1.6 Decimal separator in numerical values

In this document, a period is used to indicate the decimal separator.
Example: 30.5 kg

1.7 Rights to claim under limited warranty
Read the information in this documentation. This is essential for fault-free operation
and fulfillment of any rights to claim under limited warranty. Read the documentation
before you start working with the product.

1.8 Product names and trademarks

The brands and product names in this documentation are trademarks or registered
trademarks of their respective titleholders.

1.8.1 Trademark of Beckhoff Automation GmbH
EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff
Automation GmbH, Germany.

1.9 Copyright notice

© 2019 SEW‑EURODRIVE. All rights reserved. Unauthorized reproduction, modifica-
tion, distribution or any other use of the whole or any part of this documentation is
strictly prohibited.
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2 Safety notes
2.1 Preliminary information

The following general safety notes serve the purpose of preventing injury to persons
and damage to property. They primarily apply to the use of products described in this
documentation. If you use additional components, also observe the relevant warning
and safety notes.

2.2 Target group

Software specialist Any work with the software may only be performed by a specialist with suitable train-
ing. A specialist in this context is someone who has the following qualifications:
• Appropriate training
• Knowledge of this documentation and other applicable documentation
• SEW‑EURODRIVE recommends additional training for products that are operated

using this software.

2.3 Network security and access protection
A bus system makes it possible to adapt electronic drive technology components to
the particulars of the machinery within wide limits. There is a risk that a change of pa-
rameters that cannot be detected externally may result in unexpected but not uncon-
trolled system behavior and may have a negative impact on operational safety, system
availability, or data security.
Ensure that unauthorized access is prevented, especially with respect to Ethernet-
based networked systems and engineering interfaces.
Use IT‑specific safety standards to increase access protection to the ports. For a port
overview, refer to the respective technical data of the device in use.

2.4 Designated use

The DriveRadar® DataCollector is used to manually or automatically record and save
parameter data of frequency inverters and controllers from SEW‑EURODRIVE in peri-
odic intervals.
Observe the documentation for the components used.
Unintended or improper use of the product may result in severe injury to persons and
damage to property.
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3 System description
3.1 Introduction

Implementing a smart factory requires recording device data to obtain valuable in-
sights on the state and diagnostics of machines and systems.
With its automatic recording and saving of IIoT sensor data from electronic SEW drive
systems of generation B (control cabinet and decentralized drive technology), the
DriveRadar® DataCollector enables easy access to the required information.
The software can be set up on field customer IT systems, on edge units or SEW con-
trollers. The devices are connected with the DriveRadar® DataCollector either wireless
or with cables via existing network channels (e.g. PROFINET, Ethernet) without hard-
ware retrofitting.

3.2 Functions
Overview of the software features:
• Providing IIoT sensor data from SEW frequency inverters of generation B by auto-

matic or manual recording and saving of scope data
• Providing IIoT sensor data from SEW frequency inverters and controllers of gener-

ation B by automatic or manual recording and saving of device parameter data
• Automatic parameterization of the device scopes

The following functions can be implemented according to customer needs:

INFORMATION
Contact SEW‑EURODRIVE Service for this.

• Individual could/IIoT connection e.g. based on MQTT or HTTPS as provided ser-
vice within a customer-specific project.

• Data analysis and evaluation as provided service within the scope of a customer-
specific agreement.
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3.3 Operating principle
The data extraction is performed by the MOVILINK® parameter service and the scope
functionality and is executed as follows:

Scope data Once the configured interval elapsed, the software checks the state of the device that
has been configured for data extraction (e.g. if the scope program is currently active)
and loads the defined scope template to this device.

INFORMATION
If, during the device status check after the configured interval has elapsed, the soft-
ware detects that the scope program in MOVITOOLS® MotionStudio is active, no data
extraction will occur and the interval is restarted.

If the trigger that is configured in the scope template is activated and the scope buffer
is filled, the data are extracted and saved according to the settings. Afterwards, the
software loads the configured scope template to the device again, the scope recording
is started and the interval is restarted.

INFORMATION
If a configured device is in "automatic mode"  (→ 2 31), the scope device status is
checked every 10 minutes. If the scope program is deactivated (e.g. due to a system
failure or similar), the software loads the configured scope template to the device and
restarts the scope recording.

Device parameter
data

For devices with scope function, the extraction of the device parameter data is started
after the scope recording is completed, meaning that after each scope extraction, an
extraction of the configured device parameter data is performed and saved in an addi-
tional JSON file. For devices without scope function, the extraction of device para-
meter data is started immediately after the configured interval and is also saved in an
additional JSON file.

3.4 Added value
The software offers the following benefits:
• IIoT connection and optimization of existing systems with SEW drive technology

(control cabinet and decentralized drive technology)
• Integration of the functionality without hardware retrofitting and without interfering

with the process sequence as it is connected via existing wireless or cable-base
network communication channels (e.g. PROFINET, Ethernet). See chapter
"Sample topologies" (→ 2 33).

• Providing various communication and IIoT uplink options
• Recording of parameter and scope data
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4 Project planning information

4.1 Requirements
Correct project planning and proper installation of the devices are required for suc-
cessful startup and operation.
For detailed project planning information, refer to the documentation of the respective
devices.

4.2 Hardware
The following hardware components are compatible with the software:
• MOVILINK®-capable SEW devices of the generation B

(e.g. MOVIDRIVE®, MOVIMOT®)

INFORMATION
For recording of sensor data, the software uses the Ethernet-based engineering inter-
face of the devices.

• In situations with a lot of access via the MOVILINK® parameter channel (e.g. par-
allel access of several communication nodes on one device) delays/bottlenecks in
communication may occur with some devices. For detailed information on com-
patibility of the devices, refer the to respective documentation and chapter "IIoT
sensor technology properties (extract)" (→ 2 32).

• To allow for access via other fieldbus protocols, the respective gateway must be
used. For this, observe the notes and information in chapter "Sample topolo-
gies" (→ 2 33).

4.3 Software
The following software is required for operating the software:
• Microsoft Windows (64 Bit) 7 or higher
• Microsoft .NET Framework as of version 4.7.2 

The following software is required to create scope templates:
• MOVITOOLS® MotionStudio

The MOVITOOLS® MotionStudio software is available for free on the
SEW‑EURODRIVE website (www.sew‑eurodrive.com).

For more detailed information on the hardware requirements of the individual software
components, see the documentation for the respective software.
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4.4 Licensing
For following licenses are required for operating the software:

Software license Type designation
DriveRadar DataCollector B unlimited 10axes SDR0001-000

DriveRadar DataCollector B unlimited 25axes SDR0002-000

DriveRadar DataCollector B unlimited 50axes SDR0003-000

DriveRadar DataCollector B unlimited 100axes SDR0010-000

DriveRadar DataCollector B unlimited 10axes update SDR0004-000

DriveRadar DataCollector B unlimited 25axes update SDR0005-000

DriveRadar DataCollector B unlimited 50axes update SDR0006-000

DriveRadar DataCollector B unlimited 100axes update SDR0011-000

DriveRadar DataCollector B yearly 10axes SDR0007-000

DriveRadar DataCollector B yearly 25axes SDR0008-000

DriveRadar DataCollector B yearly 50axes SDR0009-000

DriveRadar DataCollector B yearly 100axes SDR0012-000

After buying the licenses you receive a license key. Enter the license key in the "Li-
cense check" dialog when you start the software for the first time after "installa-
tion" (→ 2 13).

INFORMATION
Go to [Help] > [About] to view the current state of the license, meaning the maximum
number of supported SEW devices and how long the license is valid.

29320804747

If you want to switch licenses or renew them, go to the initial screen of the software,
open the menu bar. Go to [Help] > [About] and click on the [New] button. Enter the li-
cense key in the dialog that opens.
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5 Installation
1. Double-click the installation file setup.exe. If your PC is not connected to the In-

ternet, double click on DataCollectorSetup.msi.

ð The installation wizard opens.

28558074891

2. Follow the installation wizard.

ð After accepting the license agreement, selecting users and choosing the destin-
ation directory, the software is installed on the PC. 

INFORMATION
Aside from the program folders, files for configuration are created in the folder C:
\ProgramData\SEW\DataCollector. To ensure proper functioning of the soft-
ware, these files must not be deleted or moved. Make sure the signed in user has
reading and writing rights for this directory.

3. Start the software.

ð The "License check" command prompt is displayed.

4. Enter the license key you obtained when buying the "license" (→ 2 12) and click
[OK] to confirm your entry.

ð The software opens and is ready to use.
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6 User interface
6.1 Start screen

The start screen displays the "Device list"  (→ 2 22) with a list of devices configured
for data acquisition. When you first start the software, the list is empty.

28562121483

6.1.1 Displaying frequency inverters
Frequency inverters are displayed on the start screen as follows:

[1] [2] [3] [4] [5] [6] [7] [8] [9] [10] [11] [12]

28571481099

No. Use
[1] Status of the network connection (green = device connected)

[2] Name of device

[3] Device type

[4] Status of the scope recording (red = scope recording started)

[5] Status of the scope memory (green = memory filled)

[6] Status of triggering (green = triggering in process; green/rot -> auto trigger ac-
tive)

[7] Status of data for extraction (green = data ready for extraction)

[8] Operating mode selection

[9] Upload progress during data extraction

[10] Defined time interval for data extraction

[11] Current timer for data extraction

[12] Display of successful and failed data extractions

(To reset the values, right-click)
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6.1.2 Displaying controllers
Controllers are displayed on the start screen as follows:

[1] [2] [3] [4] [5] [6]

28571525131

No. Use
[1] Status of the network connection (green = device connected)

[2] Name of device

[3] Device type

[4] Operating mode selection

[5] Defined time interval for data extraction

[6] Current timer for data extraction

6.2 Configuration editor
The "device list"  (→ 2 22) shows device-specific properties of the devices for which
data is collected. In the corresponding editor, the devices are created and the proper-
ties are set.
In the menu bar on the start screen, click "Edit" in the "Device list" menu to open the
editor to edit the "device list" (→ 2 22).

[1] [2] [3] [4]

28571703307

No
.

Use

[1] Devices and device groups created for data acquisition

[2] Devices detected during the scan of the network. Scope-capable devices have a
blue mark on the left of the device designation. For more information, refer to the
"Scan" section in chapter "Options" (→ 2 16).

[3] Properties of the selected device

[4] Button for applying the edited configuration
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7 Settings
In the menu bar under "Settings", you will find the software settings that are described
in this chapter.

7.1 Language
Language of user interface (software restart required).

7.2 Options

Dialog with the following options for software operation:

General
• Set whether or not the last saved device list file is opened when the software is

started.
• Set in which directory the lists with identifications for SEW and customer applica-

tions are saved. The entries in the lists are available in the drop-down lists "Appl.
customer" and "Appl. SEW" during device configuration. See chapter "Device con-
figuration" (→ 2 22).
Use the respective buttons below to open the lists with "SEW identification" or
"Customer identification" for editing.

Scan
Select the network adapter used to perform a network scan. In addition, the IP ad-
dress can be explicitly specified for the scan.

Scope
Set the option for scope recording:
• Wait for valid data

Time waiting for the trigger if, after the set interval, no valid scope data is available.
• Parameterize inverter before start

Before every start of a scope recording, a parameterization of the inverter scope
function is performed. For this purpose, the parameters from the scope template
file that were assigned to the device are transferred to the device. This overwrites
the existing configuration of the scope.

• Restart recording after data acquisition
Restart the scope recording after every data acquisition and wait for the next trig-
ger. If the scope recording is started by another component (e.g. an higher-level
controller), this option should be deactivated.

• Data acquisition only with completely filled buffer

Delete incomplete scope recordings that may occur for system reasons.
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Data memory
Select data to be recorded (Scope and/or parameter data) and set the storage 
location as well as options for limiting the required memory space for locally saving 
the recorded data.

MultiTemplate
Assigning multiple scope templates to one "configured device"  (→  2  22). This way, 
different scope templates can be used for successive scope recordings, e.g. for chan-
ging the recording channel or the sample rate. By clicking the [Test] button in this re-
gister, the devices are listed that have several scope templates assigned.
To assign several scope templates to one device, a text file (*.txt) with a list of the suc-
cessive scope templates must be created for the device under C:\ProgramData
\SEW\DataCollector\ScopeTemplates. The text files are assigned to the re-
spective device using the file name:
IP target address of the device  +  R  +  Routing info of the device  .  txt z.  B.
192.168.10.12R2.1.1.1.txt

The text file must contain the entire path to the used scope templates, one line per 
path in the desired order, e.g.
C:\ProgramData\SEW\DataCollector\ScopeTemplates\vorlage1.SCT

C:\ProgramData\SEW\DataCollector\ScopeTemplates\vorlage2.SCT

The scope template is loaded after data acquisition and before the next scope record-
ing starts. When the scope template of the last line in the text file has been used, the 
scope template of the first line is used again.
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Start scope function (scope recording) for all configured devices, when starting the 
software. No scope templates are transferred.

• Start automatic mode of devices
Start the automatic mode for all configured devices, when starting the software.  
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7.3 Meta data
Specifying information regarding the PC on which DriveRadar® DataCollector is ex-
ecuted. This data is saved in every generated JSON file.
The meta data comprise the following information:

29134125451
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8 Startup
8.1 Startup procedure

The schematic diagram below shows the startup procedure:

MOVITOOLS® MotionStudio

Create scope template/research
parameter

Startup

DriveRadar® DataCollector Configure device list

Start operation

(optional)

28558684811

8.2 Scope templates
MOVITOOLS® MotionStudio is used to create scope templates to link frequency in-
verters to the DriveRadar® DataCollector. The MOVITOOLS® MotionStudio software is
available for free on the SEW‑EURODRIVE website (www.sew‑eurodrive.com).
This chapter briefly describes all necessary steps in MOVITOOLS® MotionStudio for
data acquisition of scope recordings with the DriveRadar® DataCollector.
For more information on using MOVITOOLS® MotionStudio, refer to the respective
documentation. The manual on how to use scope functions can be opened via the
[Help] menu. Further, the manual on scope functions is stored in the installation direct-
ory of MOVITOOLS® MotionStudio via the following path: ...\Program Files\SEW
\MotionStudio\Help\SEWScope_Manual.pdf

8.2.1 Configuring scope

ü MOVITOOLS® MotionStudio is opened and a project is created.

1. Configure the communication ports in your project and scan the network.

ð The devices detected in the network are added to your project.

2. Open the context menu of the inverter and, in the "Diagnostics" submenu, click on
"Scope (Offline)".

ð The "Scope" window appears.

3. In the menu bar of the window, click "Set recording..." under "editing".

ð The "Scope settings" window appears.
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[7]

[6]

[5]

[1] [2]

[3]

[4]

28582211851

No. Designation Use
[1] Start recording Apply configuration and start scope recording

[2] Sampling cycle in ms Time interval in which the measured values are
written into the scope memory.

[3] Pre-trigger Pre- and post-trigger time

[4] Trigger mode Select between manual, analog and digital

[5] Trigger terminal Select a digital input or output of the device

[6] Maximum runtime Time resulting from the size of the scope memory
on a device and the set sampling cycle

[7] Measured value channel
assignment

Set parameters to be recorded

4. Configure the scope recording using the available setting fields.

5. Test the configuration by manually starting a recording using the buttons in the
"Recording" area ([Start] scope recording, if required [Trigger] manually and [Load]
scope template on the device).

6. In the scope settings window, click the [Close] button.
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8.2.2 Save scope as template
Save the configured scope device settings as template file to link it during the config-
uration of a device in the DriveRadar® DataCollector.

ü The "Scope" window of an inverter is opened in MOVITOOLS® MotionStudio. See
chapter "Configuring scope" (→ 2 19).

ü The scope template has been loaded to the device.

1. In the "File" menu bar, click "Save as template...".

2. Select a storage location and a file name for the template and click [Save].

ð The scope settings are saved as a scope template (*.sct) at the defined storage
location.
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8.3 Device list
Configuration of devices is realized via the "Device list" menu on the "Start
screen" (→ 2 14) of the DriveRadar® DataCollector.

1. For configuring new devices and device groups, click [Edit] in the "device list"
menu on the start screen.

ð The "configuration editor" (→ 2 15) opens.

8.3.1 Device configuration

1. In the "Scan list", click the  button.

ð All devices detected in the network are displayed in the "Scan list". Go to "Op-
tions" (→ 2 16) for the scan settings.

2. Move the devices you want to use for data acquisition from the "Scan list" to the
"Devices/groups" area using drag & drop.

3. In the "Devices/groups" area, select the device that you want to configure for data
acquisition.

ð The properties of the selected device are displayed in the window on the right.

28564967819

4. Configure the data acquisition with the device settings.
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The following properties and settings are available for the devices:

Characteristic Description
Group Group assignment of the device.

See "Grouping devices" (→ 2 27)

Signature Signature of the device

PNET PROFINET address of the device in the network

IP address IP address of the device in the network

Device address Device address in the network

IP addresses as well as subaddresses and subchannels are
used to uniquely identify the device in the network. For a better
overview, you can display the communication settings in
MOVITOOLS® MotionStudio using the keyboard shortcut "Ctrl
+ Shift + K" for each device in the network.

29186320907

Firmware Firmware version of device

Designation Designation of device

Interval [s] Interval for automatic data acquisition in seconds

Auto-trigger time [s] Auto-trigger time until start of data acquisition in seconds. Trig-
ger time for systems where triggering directly via scope is not
possible (e.g. with S1 duty cycle). The trigger time is relative
and result from:

Interval [s] - Auto-trigger time [s]
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Characteristic Description
Parameter template Select a file listing the device parameters that will be recorded

once the interval has elapsed.

Select a parameter template by clicking the [...] button. Para-
meter templates are stored in the directory C:\ProgramData
\SEW\DataCollector\ParameterTemplates.

By clicking the [Edit...] button, a window is opened in which the
selected parameter template can be edited.

Click the [New...] button to create a new parameter template.

28565412619

Scope templates Select a file containing the settings for the scope recording. For
more information on creating the file, refer to chapter "Scope
templates" (→ 2 19).

If you want to assign multiple scope templates to one device,
observe the notes on the "MultiTemplate" register in chapter
"Options" (→ 2 16).

If the check box "Parameterize inverter before start" is activa-
ted in the "Scope" register of the "Options" (→ 2 16), the con-
tent of the scope template is transferred to the inverter before
each start.
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Characteristic Description
Parameter destina-
tion file name

Name of the file in which the parameters are saved. You can
set the storage location of the "Data memory" register in the
"Options" (→ 2 16). You can freely select the file name. Refer
to the figure below on information on which placeholders can
be used to create the file name.

Tip: Use placeholders to create a file name that will allow you
to assign the file to the device again later. To ensure that the
names are unique for all devices, use the placeholder
$(GUID).

29186558603

Scope destination
file name

Name of the file in which the scope data are saved. You can
set the storage location of the "Data memory" register in the
"Options" (→ 2 16). You can freely select the file name. Refer
to the figure below on information on which placeholders can
be used to create the file name.

Tip: Use placeholders to create a file name that will allow you
to assign the file to the device again later. To ensure that the
names are unique for all devices, use the placeholder
$(GUID).

29186558603

Appl. Customer Customer application to which the device is assigned (e.g. for
structuring the recorded data for evaluation). The list of applic-
ations can be maintained in the "General Information" tab un-
der "Options" (→ 2 16).
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Characteristic Description
Appl. SEW SEW application to which the device is assigned (e.g. for struc-

turing the recorded data for evaluation). The list of applications
can be maintained in the "General Information" tab under "Op-
tions" (→ 2 16).

Group drive Define the device as group drive.

Standby drive Define the device as standby drive.

Motor part no. Serial number of the motor

Inverter part no. Serial number of the inverter

Connection type Connection type of the drive

IPOS® app Designation of the IPOS® application (is filled out automatically)

Building Hall in which the device is located

Location Location in which the device is located

Ref ID/OR ID Reference ID / Operating resource ID of the device

Comment Other comments
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8.3.2 Grouping devices
For a better overview, the configured devices can be grouped in the software. This
way, you can define certain settings for one group and thus for all devices within this
group.
Perform the following steps to group devices:

1. In the "Configuration editor"  (→  2  15), right-click on the context menu of the
"Devices/Groups" area and select the "Create new group.." menu item.

28565565195

ð A window opens where you can specify the group name.

2. Enter the group name and click on [OK].

ð The group is added to the "Devices/Groups" area.

3. Add devices from the "scan list" or from the "Devices/Groups" area to the group
using drag & drop.
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4. Mark the created group in the "Devices/Groups" area.

ð The properties of the group are displayed.

28565568651

5. Configure the group using the available setting fields. The following properties and
settings are available for the groups:

• Name of the device group
• Parameter templates for group members

Select a file in which the device parameters are described that will be recorded
once the interval has elapsed. The template file is assigned to all devices that are
members of the group. A template file already assigned to the device is overwrit-
ten.

• Scope template for group members

Select a file containing the settings for the scope recording. The template file is as-
signed to all devices that are members of the group. A template file already as-
signed to the device is overwritten.

• Parameter destination file name for group members

Define the parameter destination file name. The destination file name is assigned
to all devices that are members of the group. Any name already assigned to the
device is overwritten in the process.

• Scope destination file name for group members

Define the scope destination file name. The destination file name is assigned to all
devices that are members of the group. Any name already assigned to the device
is overwritten in the process.
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8.3.3 Saving the configuration

1. To save the configuration click "Save" or "Save as..." in the "Device list" menu of
the menu bar on the start screen.

ð With "Save", the configuration file (*.json) is saved in the directory C:\Pro-
gramData\SEW\DataCollector\Config; with "Save as..." it is saved at the
specified storage location.

INFORMATION
Under "options"  (→ 2 16), you can set that the configuration that was saved last is
used when the software is started.
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9 Operation
9.1 Operating modes

The software has "manual mode" and "automatic mode".
Manual mode is used to support startup, e.g. testing the function, configuration, or
scope resolution. In this operating mode, the scope function can be initially parameter-
ized manually with the configured scope template.
Automatic mode is used exclusively to automatically execute the configured acquisi-
tion of IIoT sensor data.

9.2 Activating manual mode
Proceed as follows to use manual mode:

1. On the start screen, activate the "Manual" check box for all devices that you want
to control manually. If you want to activate manual mode for all devices on the start
screen, click "Activate manual mode for available devices" under "Mode" in the
menu bar.

ð The selected devices can be controlled manually using the buttons on the start
screen. As controllers do not have any scope function, only the button [Param
upload and save] is available for these devices.

ð The settings for saving parameter and scope data, the file names and the stor-
age locations are inherited from the "Device list" (→ 2 22).

2. Control operation using the following buttons on the start screen:

[1] [2] [3] [4] [5] [6]

28587363851

No. Use
[1] Start scope recording

[2] Stop scope recording

[3] Set trigger

[4] Upload and save scope data

[5] Upload and save parameter data

[6] Initial download of scope template to the frequency inverter

9.3 Initialize devices
In manual mode, all scope-capable devices of the network can be initialized, meaning
the configured scope template can be loaded to the respective devices.
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Proceed as follows:

1. Activate "manual mode" (→ 2 30) for all devices you want to initialize.

2. On the start screen click the [Initialize scope] button.

9.4 Starting automatic mode
Proceed as follows:

1. On the start screen, deactivate the "Manual" check box for all devices that you
want to operate in automatic mode.

2. Click "Start automatic mode for available devices" in the menu bar under "Mode".

ð Automatic data acquisition of the devices is started.

ð If the set trigger occurred, an upload of the scope memory and/or the selected pa-
rameters is realized after the set time has elapsed.

ð Depending on the settings, the collected data are saved as .JSON files at the set
location.
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10 Appendix

10.1 IIoT sensor technology properties (extract)

Number of
scope
channels

Storage
depth (in
bit)

Number of
measuring
points

Memory size
(in kB)

Maximum
sample rate

Single para-
meter ex-
traction

MOVIAXIS® MXA 8 32 2048 64k 500µs

(250µs)

MOVIAXIS® MXR 8 32 2048 64k 62,5µs

MOVIDRIVE® B 8 16 2048 32k 1 ms

MOVITRAC® B 4 (8) 16 2048 32k 1 ms

MOVIGEAR® 8 16 2048 32k 1 ms

MOVIFIT® 8 16 2048 32k 1 ms

MOVIDRIVE® MDR 8 16 2048 32k 1 ms

MOVIMOT® - - - - -

DHx21B - - - - -

DHx41B - - - - -

UHX71B - - - - -
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10.2 Sample topologies

INFORMATION
Do not execute MOVITOOLS® MotionStudio and DriveRadar® DataCollector for one
device at the same time as that may impair the functionalities.

10.2.1 Data acquisition via PROFINET

INFORMATION
Make sure that sufficient bandwidth for parameter channel communication is avail-
able for the DriveRadar® DataCollector via PROFINET.

• SEW drives are subordinate to a PROFINET controller. Other Ethernet-based pro-
tocols (EtherNet/IPTM, Modbus TCP, ...) are also possible.

• The DriveRadar® DataCollector is locally installed on your PC.

29323502475

10.2.2 Data acquisition via Wi-Fi
• SEW drives are subordinate to a PROFIBUS controller.
• The DriveRadar® DataCollector is locally installed on your PC.
• The PC and the SEW drives simultaneously communicate via Wi-Fi. A DFE32B

option card is used as the gateway between Ethernet and the SEW system bus.

29323602827
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10.2.3 Data acquisition via SEW system bus and gateway
• The SEW drives are controlled and monitored locally via I/Os.
• The DriveRadar® DataCollector is locally installed on your PC.
• The PC and SEW drives are connected via an Ethernet network. A DFE32B is

used as the gateway between Ethernet and the SEW system bus.

29323597067

10.2.4 Data acquisition of single parameters

For devices without scope functionality such as MOVI-PLC® DHE41B or MOVIMOT®

data acquisition of single parameters is possible.
• SEW drives are controlled locally or via controller.
• The DriveRadar® DataCollector is locally installed on your PC.
• The PC and SEW drives are connected via an Ethernet network. The compact

control MOVI-PLC® DHE41B is used between the Ethernet network and the serial
bus.

29323499531
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